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Chapter 1: Introduction 

eMAM is now integrated with Adobe Photoshop CC, a raster-based software application that lets you 

create and edit images and then save them in one of many formats. Photoshop has a number of tools 

which can be used to manipulate and edit–duplicate images with other tools like cropping, slicing, magic 

wand, lasso, eraser and marquee etc. Using eMAM Panel for Adobe Photoshop, designers and editors can 

search for and find graphic elements managed by eMAM and import them to the current working 

Photoshop document. The Export option allows you to synchronize the elements back to eMAM for 

project management, central asset management and archive. The eMAM panel can track graphics 

elements used in the Photoshop documents and stores them in one or more storage locations managed 

by eMAM. The Export option in the panel makes the review, approval and final delivery processes 

seamless by automatically making PSD copies. Completed projects can be safely archived without 

affecting other documents.  

Purpose and Scope 
The purpose of this document is to describe the installation of the eMAM Panel for Adobe Photoshop and 

explain the overview of its functions, features and the supported import and export workflows in the 

eMAM system. 

System requirements 
Adobe recommends standard hardware and software requirements for Adobe Photoshop CC.  The only 

additional requirement for eMAM use would be internet access to the eMAM library.  The eMAM Panel 

is HTML5 based, so it is only supported in CC versions of Adobe Photoshop. 

Installation 
You can install eMAM Panel for Adobe Photoshop from eMAM Director>My Account page or 

download.htm page using any of the two methods mentioned below using: 

• Command Line Tool, Or 

• App Manager.  

Refer eMAM Panel for Adobe Photoshop Installation Guide doc for installation steps. 

Note: The latest version of Adobe tools including Adobe Photoshop uses Common Extensibility Platform 

(CEP) version 11. eMAM system must be upgraded to 5.2.18 to extend the support for CEP 11.  

For more details, refer: http://emamonline.smartertrack.com/kb/a362/adobe-common-extensibility-

platform-cep-11-upgrade.aspx 
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Panel Configuration Files and Folders 
The Adobe panel configuration files are automatically created once the eMAM panel is opened in each 

Adobe applications. However, these config files do not get created or removed during Panel installation 

or removal respectively. Old panel settings are preserved during the new eMAM patch update. But you 

can also manually remove the old configurations from the below-mentioned locations. 

Folder: Photoshop panel config files are created inside eMAMPHXS_CONFIG folder: 

Windows: C:\Users\Public\eMAMPHXS_CONFIG 

MAC:  /Users/shared/eMAMPHXS_CONFIG 

 

Figure 1- Photoshop panel configuration folder 

Files: Listed below are the panel configuration files that are stored in each panel config folder. 

• eMAMConfig.json: All the important configuration details to run the eMAM Panel like eMAM server 

info, username, password, default folders for storing the projects/media/etc. are found in the 

eMAMConfig.json file. Users can overwrite the existing settings by manually editing this JSON file.  

 

 

Figure 2- eMAMconfig json file with config details 
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• data.json: This file will have details of the exporting .psd document and its ingest progress details. 

These are temporary details which gets deleted after successful export of the file. 

 

 

Figure 3-data.json file with export details. 

 

• Log files: eMAMLog.log,eMAMLog1.log, eMAMLog2.log etc.- It consists of three levels of logs- 

information related, error related, and exception related. These log files are required by the eMAM 

support team to troubleshoot issues (if any). 

 

Figure 4- eMAM pane log files. 

  

http://www.emamsolutions.com/


eMAM PANEL FOR PHOTOSHOP USER GUIDE 

© 2021 EMAM, Inc. 
7 www.emamsolutions.com 

 
 

Chapter 2: Getting Started 

This chapter explains how to launch Adobe Photoshop and open eMAM Panel in the Adobe Photoshop. 

Open the eMAM Panel in Adobe Photoshop 
Follow the steps below to open eMAM Panel in the Adobe Photoshop CC: 

1. Launch and open the Adobe Photoshop CC installed on your machine. 

 
Figure 5: Launch Adobe Photoshop by running as administrator 

 

2. Open a new or an existing Photoshop document.  

 
Figure 6-Open New or existing Photoshop document 

 

3. From the Adobe Photoshop top menu panel, go to Windows>>Extensions>>eMAM to open eMAM 

Panel. 

 
Figure 7: Open Photoshop Panel 
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4. After a while eMAM Panel opens up and asks you to enter your eMAM server URL details. Replace 

the default server URL details with your eMAM server name and click on OK. For e.g.: 

http://servername/  

 
Figure 8: eMAM server URL 

 

5. Now login to the eMAM Panel, using eMAM login credentials provided by your eMAM unit 

administrator and click on GO. Use Change Server to change the server details. 

 
Figure 9: eMAM Photoshop Panel login 

 

6. Now choose the unit you wish to login. (Only in cases where user account is associated with many 

units) 

 
Figure 10: Choose Unit at login  
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7. The eMAM Panel opens up in the Adobe Photoshop as shown below. By default, Assets tab is 

displayed. 

 
Figure 11: eMAM Panel window open in Adobe Photoshop 
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Chapter 3: Overview of eMAM Panel for Photoshop 

This chapter describes the overview of the eMAM Panel for Photoshop including its various buttons, tabs, 

functions and features. 

The eMAM Panel for Photoshop 
Shown below is a snapshot of the eMAM Panel for Photoshop. Various tabs, functions and buttons are 

explained in detail below. 

 
Figure 12: eMAM Panel for Photoshop overview 
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1. Assets tab 

The Assets tab displays all the image assets managed by eMAM which can be imported to Adobe 

Photoshop. All the assets are displayed with details like asset name, ingested-on date, size and 

extension of assets. Archived assets (which exist only in the archived location) are displayed with a red 

line underneath. 

 
Figure 13: Assets tab 

 

Options available under the Assets tab are: 

• Search filter: Search filter displays list of all Saved filters from eMAM Director interface 

which can be used to search for assets in eMAM Photoshop Panel. 
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• Sort options: You can sort the assets displayed based on various criteria like most recent, 

size, name, rating, description, category, ingested on and ingested by. 

 
 

• Order by : Click on Order by to sort the assets in ascending and descending order. 

• Type: Filter the assets based on asset type (images, videos, audios and other files). By 

default, all image files are displayed in the eMAM Photoshop Panel. 

 
 

• Asset per page: You can use this option to change the no. of assets (10, 50, 100, 150, 200, 

250) displayed per page. 

 
 

• Page navigation : This displays the current page no. and the next/previous 

buttons to navigate between the pages.  
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2. Categories tab 

The Categories tab in the eMAM panel displays all the categories created in the eMAM system that 

you can import to the eMAM Photoshop Panel. 

 
Figure 14: Categories tab 

3. Photoshop Document tab 

This tab shows the name of the currently open Photoshop document.  You can use the Save and 

Save As buttons to save and export the final Photoshop document(.psd)/new version of file back to 

the eMAM system. When there are multiple documents in the Photoshop, panel will be showing 

the name of the active document in the document tab. 

If the document is not saved there will be a * symbol at the end. Note: The unsaved files show a * at the 

end of the document name. Save the photoshop doc before exporting it back to eMAM. 

http://www.emamsolutions.com/


eMAM PANEL FOR PHOTOSHOP USER GUIDE 

© 2021 EMAM, Inc. 
14 www.emamsolutions.com 

 
 

                                                                        
Figure 17: Photoshop document tab 

a. Save: Save button is used to add new Photoshop document to eMAM. If the document 

already exists in eMAM, it will create a new version of the same on export of the Photoshop 

doc  

b. Save As: Save As button is used to export an already existing eMAM Photoshop document/ a new 

Photoshop document to any other format back to the eMAM system. During export, you can 

choose from the different export formats listed for Save As Type under Save as Options. You can 

find the Save As type pre-set config details in a priest Jason file in the eMAM Gateway server: 

C:\Program Files\Empress Media\eMAM Gateway\PanelExportPresets\Photoshop 

 
Figure 15: Save As Type export formats 

Note: Before exporting any file, ensure all the storage configurations are correct in the Settings window. 
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4. Dashboard 

Dashboard tab displays all the errors that occurred during an export workflow. These errors can be 

either resubmitted or deleted from the dashboard using Retry & Delete buttons. 

 
Figure 16: Dashboard tab displays errors occurred during export workflow. 

 

✓ The Photoshop Panel dashboard only displays the errors occurred during an export workflow. For all 

other workflows including Archive/Restore, please monitor eMAM Director dashboard.  

✓ To refer the log file, configuration. json with server name encrypted username, password details, go to 

C:\Users\Public\eMAMPHXS_CONFIG 

5. Search  

Search bar can be used to search for categories and assets under respective tabs. Just key in your 

search word or phrase, click on the Go button and results are displayed. Based on the words entered 

in the search bar, eMAM will auto populate and display the matching items for you to choose from. 

Click on icon next to the search phrase to clear the search results. 

 
Figure 17: Search field- suggestions auto populated 
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Figure 18: Search box 

 

6. Import 

You can import the assets and files under Categories and Assets tab from the eMAM system to the 

eMAM Photoshop Panel. You can find the panel export pre-set config details in a pre-set Jason file in 

the eMAM Gateway server: 

C:\Program Files\Empress Media\eMAM Gateway\PanelExportPresets\Photoshop 
 

List of formats that can be imported from eMAM to Photoshop panel are:  

"psd", "jpg",  "jpeg", "exif",  "png",  "tiff", "tif", "wmf", "icon", "bmp", "dpx", "gif", "eps", "pdf", "raw", 

"pxr", "tga" 

You have 2 options for import, either you can: 

a. Import as new layer: Single file/multiple files and Categories/sub categories can be imported 

to Photoshop panel as new layers.  

 
 

Figure 19: Import of assets as layers 
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Note:  

• .psd files cannot be imported as a layer. Any such attempt will display below error message. 
 

 
Figure 20: Message- Panel cannot import .psd file as a layer. 

• Archived assets cannot be imported without restoring it. Any such attempt will display 
below error message. 

 
                   Figure 21: Message to restore archived asset or unselect it before import 

• Category and Subcategory import will not create any tree structure in the Photoshop 
Panel. 

 
Once files are imported as new layer, localization of assets begin. You can view the real-time progress 
of each asset. 
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b. Import as new file: A single file (.psd or image) can be imported to Photoshop Panel as a new 

file.  

 
Figure 22: Import of .psd file as a new file 

Note:  

• Multiples files cannot be imported as a new file. Any such attempt will display below 
error message. 

 
Figure 23: Message - panel can import only single .psd file or a single image file 

• Categories/Subcategories and multiple image files cannot be imported as a new file. Any 
such attempt will display below error message. 
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Figure 24:Message - Cannot import Category as a new file 

7. Archive 
Click on the Archive button to archive the selected assets under Categories or Assets tab to the pre-

set archive profiles. Archive-Restore Status window displays the status of archived assets. You can 

monitor the eMAM Director>Archive dashboard to see the status of archive of each asset. Note: 

archived files cannot be imported. They need to be restored before import. 

 
Figure 25: Archive status window 

8. Restore 

Likewise, click on the Restore button to restore the archived assets. Archive-Restore Status window 

displays the status of restored assets. You can monitor the eMAM Director>Archive dashboard to see 

the status of archive of each asset. 

 
Figure 26: Restore status window 

9. Refresh 

In a multi-user environment, users can work simultaneously on the same project. The Refresh button 

updates the extension Panel with the latest information in the eMAM. 
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Figure 27: Refresh icon 

 

10. Settings 

Using this Settings button, you can define where the Photoshop document needs to be stored when 

it is exported back to eMAM.  You can select from any of the storage profiles in the dropdown list 

configured in the Super Admin Console. 

 
Figure 28: Settings window 

 

a. Storage profile: Select from the listed the Storage profiles to store the Photoshop doc. On 
the export of a PSD file, eMAM panel will move the original PSD file to the corresponding 
high-res folder with UUID name, and a flattened 172*132 thumbnail image, 640*360 proxy 
image to the corresponding low-res folder with UUID_1.jpg and UUID_2.jpg respectively. 
 

b. Local path for assets: Browse and select the local path for assets which is used to store the 
localized image files and PSD files. 
 

c. Local path for export: Browse and select the local path for export which is used to store the 
flattened thumbnail and proxy files for uploading them into eMAM storage. These files will 
be temporarily stored in this folder and will be deleted after they are uploaded into eMAM 
storage. 

 

: Red icon indicates no connection to the mentioned UNC path. 

: Green icon indicates connection established with the mentioned UNC path.  

http://www.emamsolutions.com/


eMAM PANEL FOR PHOTOSHOP USER GUIDE 

© 2021 EMAM, Inc. 
21 www.emamsolutions.com 

 
 

11. List view 

Click on  icon to view items under Assets and Categories tab in list view. 

 
Figure 29- Assets tab in List view 

 

12. Thumbnail view 

Click on  icon to view items under Assets and Categories tab in list view. 

 
Figure 30- Assets tab in Thumbnail view 
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13. Username 

Logged in username 

14. Logout 

Click on  icon to logout from your account. 

15. Asset Options window 

Double click on any asset under the Assets tab or Categories tab to open Asset Options window. Asset 

Options window displays details of the asset such as the Title, its location status (online/nearline), 

thumbnail and various tabs to update metadata, review the history of the asset, review comments 

added to an asset, send approval requests, and File versions. 

 
Figure 31: Asset Options window  
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a. Preview tab: By default, Preview tab appears. You can preview any asset individually and view 

its properties like name, status etc. 

 
Figure 32: Asset Options window- Preview tab 

 

b. Metadata tab: You can see all the metadata details of the asset like Info, Embedded metadata, 

Custom metadata, and tags under different fields. You also have the option to edit and update 

metadata details of the asset as needed. Under Custom metadata, metadata values can be multi 

selected. 

 
Figure 33: Asset Options window- Metadata tab 

 

• Info: Displays details of the asset title (editable field), description (editable field), author 

(editable field), uploaded on, uploaded by, Metadata set (editable field), projects, 

categories. Editable fields can be updated using Update button. 
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Figure 34: Asset Options window- Metadata tab>Info tab 

• Embedded Metadata: Embedded metadata is extracted by the system at ingest and is 

non-editable. These are technical and camera information about an asset, including file 

name, format, and size, bit rate, format information etc. 

 
Figure 35:Asset Options window- Metadata tab>Embedded Metadata tab 

 

• Custom Metadata: Custom metadata fields are the custom metadata fields created by 

the users. You can make changes and update the changes using Update button. 

 
Figure 36: Asset Options window- Metadata tab>Custom Metadata tab 
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• Tags: This tab displays keywords attached to the asset which can be used for searching 

the asset. 

 
Figure 37: Asset Options window- Metadata tab>Tags 

c. History tab: History tab displays asset details and entire history of functions performed on the asset. It 

displays Date of Actions, Action Performed, Username and id of the user who performed the action.  

 
Figure 38: Asset Options window- History tab  
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d. Comments tab: Comments tab allows you to view and add comments. Displays username, 

comment written by the user and date when the comment was written. Comments written on 

different interfaces (assets, approval, eBIN) are displayed here. You can also add comments by 

entering comments and clicking on the Add Comment button. 

 
Figure 39: Asset Options window- Comments tab 

 

e. Approval: Users may be required to send the asset for approval to another person, internal or external 

to the organization. An asset can be sent for approval to another eMAM user (internal approval) or 

externally as a link to someone who has no access to eMAM (external approval).  

 

o Send to internal user: Choose the name of the internal user from the drop-down list and click 

on Send for Approval button. 

 
Figure 40: Asset Options window- Approval tab>Internal approval 
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o Send to client for approval: To send to the external client for approval, enter email address of the 

client, username, password and choose the expiry date for the link. 

 
Figure 41: Asset Options window- Approval tab>External approval 

 

f. File Versions: File Versions displays the list of all the different versions created and available for the same 

asset. To import a particular version of an asset, set it as Face version before import. 

 
Figure 42: Asset Options window- File Versions tab 
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Chapter 4: Import and Export Workflow 

To import assets from the eMAM system to the Adobe Photoshop CC using eMAM Photoshop Panel, 

follow the steps below: 

Import 
a. Launch Adobe Photoshop CC on your machine and create a new Photoshop document. Enter 

Doc name and click on Create button. 

 

Figure 43: Create a new Photoshop doc 

 

b. When you right click on the newly created .psd name, you will see the ‘Reveal in Explorer’ 

disabled, which means .psd is not yet saved. 

 

Figure 44:Reveal in Explorer disabled 
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c. Go to File and click on ‘Save As’ and save it as a .psd file after which “Reveal in Explorer” gets 

enabled. 

 
Figure 45: Save the Photoshop doc 

 

d. Open eMAM Panel (Window>Extensions>eMAM). 

 

Figure 46: Open eMAM Panel (Window>Extensions>eMAM) 

e. Now configure (one-time activity) the eMAM panel by clicking on the Settings button at the top 

right corner.   
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Figure 47: Settings- Configure the storage profile and asset paths 

f. Now select single/multiple image assets under Assets tab and click on Import as new layer. After 

a while when all assets are imported successfully, the message below appears. 
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Figure 48: Select assets under the Assets tab 
 

Note: The unsaved files show a * at the end of the document name so if you missed to save 

the Photoshop doc, please save it from File>Save As. 

 

g. Localization of files start which can be viewed in real-time. 

 
Figure 49-Progress of assets getting localized 

 

h. After a while import successfully completed message appears. 

 
Figure 50- Import successfully completed message 

 

i. Imported files get displayed as layers in the Photoshop doc. 
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Figure 51: Layers listed under Layers tab in the Adobe Photoshop 

Note: On import, now AWS SDK is used to download assets from cloud storages. 

Export 
j. Now make the desired edits in Adobe Photoshop document and save your changes. When your 

final output is ready, in the eMAM Photoshop Panel, click on Save button to save and export 

the .psd file back to eMAM.  
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Figure 52: Click on Save under Photoshop doc tab. 

*If a .psd file is imported from eMAM and is exported back to eMAM, you will be asked 

to export as a new version of the file with below message. 

 
Figure 53: Warning message to export as new version. 

k. Fill in the details under each tab before export: 
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Figure 54: Fill in details before export 

o Photoshop Details (on clicking Save button): Fill in the Description and Author 

field. 

 
Figure 55: Photoshop details tab 

 

o Save as Options (on clicking Save As button): When a .psd file needs to be exported 

as a new version of the already existing file in eMAM, select the file save as type 

from the drop-down list. Enter Description and Author name. Note: Save As option 

is only available for saved .psd files. 

 
Figure 56: Photoshop doc export Save As options 

o Categories: Under Categories tab, enable the desired Category checkboxes you 

wish to assign this photoshop doc to. 
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Figure 57: Export- Categories tab 

 

o Tags: Under Tags tab, click and choose from the listed tags or add new tags and 

click on  button. 

 
Figure 58: Export- Tags tab 

 

o Custom Metadata: Under this tab, select the Metadata Set from the dropdown 

list and fill in the Metadata fields. 

 
Figure 59: Export- Custom Metadata tab 

l. Once all the details are filled, click on OK on the top right-hand side of the page. Click Cancel to 

discard the changes.        

      
                                                              Figure 60: Click OK to start the export 

 

m. After a while, once the export is successfully completed, below message appears. 

http://www.emamsolutions.com/


eMAM PANEL FOR PHOTOSHOP USER GUIDE 

© 2021 EMAM, Inc. 
36 www.emamsolutions.com 

 
 

 
Figure 61: Export completed message 

n. You can now find the final exported Photoshop doc listed as a .psd file under the Assets tab. 

 
Figure 62: Photoshop doc added as a psd file under Assets tab.  
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Chapter 5: Archive/Restore workflow 

Archive 
To archive assets under the Assets tab or the Categories tab to the pre-defined Archive location, 

follow the steps mentioned below: 

1. In the eMAM Photoshop Panel, under the Assets tab, select the assets for archive and click 

on Archive button on the top panel. 

 
                                                          Figure 63: Select assets and click on Archive 

 

2. Asset -Restore Status window appears and displays the status of each archived asset. On successful 

queuing of the asset to the archive queue, it will display below message. 
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                                      Figure 64: Archive-Restore Status window displays status of archive 

Archive operations can fail for many reasons. Various failed scenarios with the corresponding 

messages displayed during archive process are mentioned below: 

 
Figure 65: Archive-Restore Status window with failed messages 

 

a. No archive profile configured for the asset: This means the storage profile where this 

asset is stored does not have an archive profile configured, hence the archive process 

fails. You can go to the asset storage profile in the Super Admin console and configure 

an archive profile for the same. 

b. Asset is in queued or running status: This means, the archive process for this asset 

has already begun and is in either queued or running state. 

c. Asset already archived: This message is displayed when the selected asset is already 

in archived state. 

 

3. Immediately check the eMAM Director>Archive dashboard to monitor the progress of the 

archive operations. After a while, all the archived assets get successfully archived to the pre-

configured archive locations. You can confirm it by retrying the archive operation on the same 

asset, and if it displays Asset already archived message, it means the asset is already archived. 

Also, in the eMAM Director>File Version widget, it will display Exist in archive as the asset 

location. 
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Figure 66: File Versions widget displays location of asset as archive 

 

Restore 
Similarly, you can restore the archived asset by following the steps below: 

1. Select the archived assets, you wish to restore under the Assets tab and click on the Restore button 

on the top panel. 

 
Figure 67: Select the archived assets and click on Restore 
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2. Archive-Restore Status window displays the status of the restore operations. 

 
              Figure 68: Archive-Restore Status window displays status of restore operations 

If you try to restore a non-archived asset, you will receive below message: 

 
Figure 69:Message displayed when trying to restore a non-archived asset 

3. Immediately, check the eMAM Director>Archive Dashboard queue, to monitor the status of restore 

operations for each asset. 

 
Figure 70:eMAM Director>Archive Dashboard 

4. Files are successfully restored from the archive locations which can be confirmed looking at the eMAM 

Director File Versions widget. 
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Figure 71:File Versions widget displays storage location of asset 

Chapter 6: Get Help 

For any more information, please contact eMAM support at support@emamonline.com 
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